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Chapter 1. Introduction

About this Document
This document is intended to provide step-by-step instructions for the initial con-
figuration of your Gentner for use in an Access Grid (AG) node. It is not intended
to replace the Gentner manuals for the echo cancellation device and software
tools, and should instead be considered a companion piece to them. It is also not
intended to serve as a guide to Gentner operations during AG events, or as a
troubleshooting guide; however, documents along these lines would be worthy
contributions to the Access Grid Documentation Project1, and the author encour-
ages interested parties to contact him at <aspale@evl.uic.edu > about develop-
ing such documents.

This document assumes that

1. your AG node (including your Gentner) is consistent with the AG Equip-
ment Specification

2. you have already installed AG Toolkit 1.0 on your Audio machine

3. you have installed Windows 98 on your Control machine

4. you have set up all the necessary cabling between the Gentner and
your Control machine, most likely as described in Gary Refka’s
document, "Building an Access Grid Node" which can be found at
http://www.accessgrid.org/agdp/guide/building-an-access-grid-
node.html.2

5. your Control machine is connected to a network and has a web browser
installed.

Throughout this document, it is assumed that you are using the Gentner AP400.
However, savvy readers will most likely be able to set up other Gentner models
(such as the AP800) using these instructions as a general guide.

Acknowledgements
The author would like to take the time to thank Jennifer Teig von Hoffman of
Boston University who wrote the previous version of this document and pro-
vided advice and answered questions patiently.

Because the version of this document is built largely on the previous work, I
would like to continue to acknowledge the contributors from the previous ver-
sion. Thanks to Jeff Shuckra of the Albuquerque High Performance Computing
Center at the University of New Mexico who provided material upon which parts
of the previous Gentner document was based. The authour would also like to
thank Lisa Childers of Argonne National Laboratory who first documented the
three recommended Gentner presets.

Conventions Used in this Document
When discussing options from Windows’ pull-down menus or other graphic in-
terfaces, the selection titles are indicated by the use of quotes.

Notes
1. http://www.accessgrid.org/agdp/

2. http://www.accessgrid.org/agdp/guide/building-an-access-grid-
node.html
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Chapter 2. Installation and Configuration

An important note: Throughout configuration of the Gentner, please keep in
mind that changes made in Gentner AP Tools software take effect immediately,
and that the state of the Gentner is saved across poweroff (i.e., powercycling will
not restore the Gentner to its original factory defaults). The Gentner control
panel in AP Tools software is not a configuration editor, which creates a
configuration that is later loaded into the Gentner; rather, it is a control panel
that changes the Gentner’s persistent state.

This is important to remember not only during initial configuration, but also with
the Gentner’s ongoing use. If at any time, for any reason, the hardware and soft-
ware configurations become out of synch, you will see an error message inform-
ing you that this has occurred; it is the experience of some in the AG commu-
nity that if this occurs, the hardware configuration will generally be in a better
state than the software configuration, which suggests that you should instruct
the AP Tools software to "retrieve device settings." (However you are unlikely to
encounter this problem during initial configuration.)

Downloading and Installing the Software, and Creating a "Site"

1. With your web browser, go to http://www.gentner.com/tech_support/index.php1

and follow these instructions in order to download the AP-Ware:

a. Click on the Downloads link.

b. Click on the AP Ware link under the AP400 or the AP800 (it should
not matter which link that you choose. Both the AP400 and AP800 use
the exact same AP Ware software.

c. If you have not registered on the Gentner web page, you will have
to register before downloading the software. On the Site Login page,
click on the link Create a New Account. Then on the Create Account
page, enter the appropriate information for each field. Once you have
finished, click on the Login image. If all information was entered suc-
cessfully, you should return to the web page named Document Library
Search Results. Refer to the previous step of where to click to continue.

d. Save the file in a directory on your computer.

2. To install the software follow these steps:

a. Locate the directory where the AP-Ware archive was downloaded.
Then double-click on the apware.exe icon to begin the extraction pro-
cess.

b. When the "Self-Extracting archive" dialog box appears, select "OK" to
begin extracting the files.

c. This dialog box will disappear and a new dialog box will appear that
will ask where to extract the archive. Type the absolute path name in
the text field, or select the directory to extract the archive by pressing
the "Browse" button and choosing the appropriate location in the hier-
archical list. When you have finished entering the absolute path name,
press "OK". The files will be extracted to the specified location.

d. Locate the directory where the AP-Ware files were extracted. The lo-
cation will contain a directory named "apware" which will contain the
files used for installation of the AP-Ware software. Once you have lo-
cated the "apware" directory, double-click on the "apware" directory,
then double-click on the "DISKS" directory, next double-click on the
"DISK1" directory, and finally double-click on the program icon la-
beled "SETUP" or "SETUP.EXE".

e. Follow the instructions given in the setup program to install AP-Ware.
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Chapter 2. Installation and Configuration

3. In order to operate the AP-Ware software properly, it is necessary
to upgrade the firmware of your AP400. To do this, use your web
browser and go to http://www.gentner.com/library/clearone_ap-
ware_t100_tech_note.pdf. Given this file is a PDF, please make sure that
you have Adobe Acrobat Reader installed on your computer. Follow the
firmware upgrade instructions given in this document.

4. If the program was successfully installed, press the Start button on the Win-
dows task bar. Then select the following menus in this order: "Programs",
"Gentner AP-Ware", "AP-Ware - Main Program." This should bring up the
AP-Ware program.

5. It will be necessary to create a new site to store the settings of the Gentner.
From the "File" menu, select "New Site".

6. After a pause, a dialog box should appear entitled "Site Properties - Site 1."

7. In this dialog box, there are two tabs labeled "Site" and "Communications".
The information that you enter into the "Site" part of the dialog box is in-
formation that should not affect the program’s operation. It is intended to
provide you the opportunity to describe your Gentner. Fill in information
appropriate to each field. Minimally, enter a name for the "Site" field. For
more information about these fields, consult the on-line help of the AP-Ware
program by pressing the F1 key or by selecting from the "Help" menu, "Con-
tents F1".

8. If you have upgraded your firmware in step 2.1.3, you may have already done this
step. It is important to fill in the "Communications" part of the dialog box.
To make this part of the dialog box appear, press the "Communications" tab
of the dialog box. It will only be necessary to fill in the first three items of
the "Communications" part of the dialog box because there is likely a con-
nection from the control machine to the Gentner. If this is not how your AG
node is configured, please consult the on-line help portion of AP-Ware by
pressing F1 or selecting from the "Help" menu, "Contents F1". Then deter-
mine what alternate and/or additional settings are necessary for the "Com-
munications" settings. For AG nodes that have a connection as described
above, please ensure that the following settings match the settings shown
in the image and in the text below.

8.i. "Comm Port:" (most likely 1; this depends on your specific installation)

8.ii. "Baud Rate:" 9600
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Chapter 2. Installation and Configuration

8.iii. "Flow Control:" None

8.iv. "Use Modem:" should not be checked.

8.v. "In the section named "Panja Configuration", "Use AMX" should not
be checked.

9. Once you have entered the appropriate information, close this dialog box by
clicking "OK". A visible change that you will see is that the title bar of the
AP-Ware program should now contain "AP-Ware - [your site name here]".

10. Now, it will be necessary to add unit(s) to this site. From the "Connect"
menu, select "Connect". AP-Ware will attempt to open the COM port and
find new units, creating icons for each that will appear on the left side of
the window. Assuming you have only an AP400 connected (and not, for ex-
ample, an AP800 chained to an AP10), an icon should be created only for
the AP400. If, after a pause, this icon does not appear, consult the on-line
help portion of AP-Ware by pressing F1 or selecting from the "Help" menu,
"Contents F1".

11. Once the AP400 icon appears in the left side of the AP-Ware window, right-
click on that icon and select the menu item "Unit Properties". This will bring
up a dialog box titled something like, "Unit Properties - AP400".

12. In this dialog box, select the tab titled "Unit". Then, enter the following in-
formation in the appropriate fields (leave the others in their default condi-
tions):

12.i. "Unit Name:" (put the kind of the unit [e.g. AP400] and possibly a
name of the unit [if there are many of the same kind of unit] here)

12.ii. "Panel Inactivity Timeout:" 10

12.iii. "Default Panel Meter Source:" Output A

12.iv. "Unit Network Address: 30 (if your site contains multiple Gentner
units, you should use a "unique" number here from the available list
of numbers)

12.v. "Lock Front Panel:" should not be checked

13. Continuing with the unit configuration, press the "Communications" tab.
All of the items appearing in this dialog box should be unable to be selected.
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If for some reason, the items in this dialog box are selectable, please ensure
that the following settings are present:

13.i. "Flow Control:" none

13.ii. "Baud Rate:" 9600

13.iii. "Use Modem: (should not be checked)" Off

14. If this has been done correctly, the text that appears below the row of icons
should say something like "Unit: AP400 (Device ID [the ID number of this
device]) [name of this device]".

Setting up the Three Recommended Presets
The presets below have been developed to ensure smooth operations during AG
sessions. It is very strongly recommended, and generally considered an AG stan-
dard, that all sites use these presets as described below.

1. Make sure the AP400 icon has its text highlighted, indicating that the dia-
gram to the right will display information related to this unit. Observe the
six buttons that appear at the top of this diagram which act as preset but-
tons. You can press one of these buttons to determine what preset should
be activated. Once you do this, remember what preset is currently active.
Anything that you see in the area to the right of the icon(s) or appearing in
a dialog box from pressing a button on the area to the right of the icon(s)
will only be relevant to the currently selected preset.

2. Press the "Matrix" button found in the top, middle portion of the diagram.
This will make the previous diagram disappear, and the matrix for the cur-
rently selected preset appear. Notice how the names of the various inputs,
outputs, etc. appear on both sides of the matrix. A cell represents the type
of connection between one item and another item. Clicking on a cell in the
matrix will result in the cell being colored according to that particular con-
nection. Sometimes a certain cell will toggle between two colors, while an-
other cell will cycle among three colors. The meaning of the colors appear
in an area named "Routing Key" in the upper-left hand corner of the main
area of the window. After you have finished viewing the matrix for this pre-
set, click on the button appearing near the "Routing Key" area of the screen
that says "AP400 flow screen". This will make the matrix disappear and the
diagram reappear. From this point on, the part of the window that has the
diagrams and buttons will be referred to as the "flow screen". An image of
the "flow screen" appears here:

3. The part of the window that has the matrix will be referred to as the "matrix
screen". An image of the "matrix screen" appears here:
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Configuring Preset 1

1. On the flow screen press the button labeled "Preset 1". After a short period
of time, the "Preset 1" button will become the current preset and the "flow
screen" will be relevant to preset 1. Click on the button in the middle of the
screen named "Matrix".

2. The matrix screen appears. Here, you will not only configure the matrix,
but just as importantly, you will configure the echo cancellation (the part
that appears below the matrix). Echo cancellation is performed by sending
the audio from the microphones to an unused output and selecting echo
cancellation to occur on this unused output channel. Another feature pre-
sented in the matrix is local reinforcement. This is typically used if you want
some of your microphones to send their audio not only to the Access Grid
but also directly to your room speakers. Because audio setups at nodes vary,
please consider the following terms:

• PC-audio-out in this matrix is labeled RX from AG (receive from Access Grid).
This is where audio would leave the sound card and enter into the room
speakers. The Mackie Mixer used in this matrix has an audio output to the
room speakers.

• PC-audio-in in this matrix is labeled TX to AG (transmit to Access Grid).
This is where any audio from any of the audio sources at your node enter
into the sound card and get transmitted to the Access Grid.

• The echo cancellation output in this matrix is labeled Ghost Output.

• In this matrix, Sub Bus is an audio input channel used primarily to route
audio inputs into the room speakers.

3. Configure the matrix and the echo cancellation so that they match the image
below:
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4. Please note that this preset is used for the Network-Telco Bridge, when your AG
node serves as a bridge between network audio and telephone audio. It is absolutely
necessary that only one site (at most) use this preset during any given AG session.
If more than one site in a given session is on preset 1, it is likely that all sites will
receive very bad feedback. In this preset:

• Inputs connected to room microphones are gated (have yellow boxes) to
telco-out and the output connected to PC-audio-in.

• Telco-in and the input connected to PC-audio-out have crosspoints (have
green boxes) with the output connected to the room speakers.

• Telco-in has a crosspoint (has a green box) with the output connected to
PC-audio-in.

• The input connected to PC-audio-out has a crosspoint (has a green box)
with telco-out.

• OPTIONAL CONNECTION-- To implement local reinforcement described
above, add these gatings and crosspoints:

• Choose the microphones who audio you would like to hear on the room
speakers. Inputs connected to the room microphones are gated (have
yellow boxes) to the column labeled Sub Bus 1.

• The row labeled Sub Bus 1 should have a crosspoint (have a green box)
with the output connected to the room speakers. On the matrix, this is
labeled PA System.

• Telco-in and the input connected to PC-audio-out have crosspoints (have
green boxes) with the unused output used for echo cancellation.

• In the part of the matrix screen labeled "Echo Cancellation Setup", select
the output used for echo cancellation in the rows labeled "Define EC Ref
and PA" and "Define G-Link Ref".

5. Once you have completed configuring the matrix and setting up the echo
cancellation, return to the flow screen by pressing the button located in the
upper left-hand corner of the screen labeled something like "AP400 Flow
Screen".
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Configuring Preset 2

1. Still in the flow screen, press the button labeled "Preset 2". After a short pe-
riod of time, the "Preset 2" button will remain pressed and the "flow screen"
should now be relevant to preset 2. Click on the button in the middle of the
scren with the title "Matrix".

2. The matrix screen appears. Here, you will not only configure the matrix,
but just as importantly, you will configure the echo cancellation (the part
that appears below the matrix). Echo cancellation is performed by sending
the audio from the microphones to an unused output and selecting echo
cancellation to occur on this unused output channel. Another feature pre-
sented in the matrix is local reinforcement. This is typically used if you want
some of your microphones to send their audio not only to the Access Grid
but also directly to your room speakers. Because audio setups at nodes vary,
please consider the following terms:

• PC-audio-out in this matrix is labeled RX from AG (receive from Access Grid).
This is where audio would leave the sound card and enter into the room
speakers. The Mackie Mixer used in this matrix has an audio output to the
room speakers.

• PC-audio-in in this matrix is labeled TX to AG (transmit to Access Grid).
This is where any audio from any of the audio sources at your node enter
into the sound card and get transmitted to the Access Grid.

• The echo cancellation output in this matrix is labeled Ghost Output.

• In this matrix, Sub Bus is an audio input channel used primarily to route
audio inputs into the room speakers.

3. Configure the matrix and the echo cancellation so that they match the image
below:

4. Please note that this is the strongly recommended preset for Telco-only, to be used
when your audio must be routed entirely (and only) through a telephone line. In
this preset:

• Telco-in has a crosspoint (has a green box) with the output connected to
the room speakers.

9
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• Inputs connected to room microphones are gated (have yellow boxes) to
telco-out.

• OPTIONAL CONNECTION-- To implement local reinforcement described
above, add these gatings and crosspoints:

• Choose the microphones who audio you would like to hear on the room
speakers. Inputs connected to the room microphones are gated (have
yellow boxes) to the column labeled Sub Bus 1.

• The row labeled Sub Bus 1 should have a crosspoint (have a green box)
with the output connected to the room speakers. On the matrix, this is
labeled PA System.

• Telco-in has a crosspoint (has a green box) with the unused output used
for echo cancellation.

• In the part of the matrix screen labeled "Echo Cancellation Setup", select
the output used for echo cancellation in the rows labeled "Define EC Ref
and PA" and "Define G-Link Ref".

5. Once you have completed configuring the matrix and setting up the echo
cancellation, return to the flow screen by pressing the button located in the
upper left-hand corner of the screen labeled something like "AP400 Flow
Screen".

Configuring Preset 3

1. As in the steps for Preset 1 and 2 above, press the button labeled "Preset 3".
After a short period of time, the "Preset 3" button will become the current
preset and the flow screen will be relevant to preset 3. Click on the button
in the middle of the screen named "Matrix".

2. The matrix screen appears. Here, you will not only configure the matrix,
but just as importantly, you will configure the echo cancellation (the part
that appears below the matrix). Echo cancellation is performed by sending
the audio from the microphones to an unused output and selecting echo
cancellation to occur on this unused output channel. Another feature pre-
sented in the matrix is local reinforcement. This is typically used if you want
some of your microphones to send their audio not only to the Access Grid
but also directly to your room speakers. Because audio setups at nodes vary,
please consider the following terms:

• PC-audio-out in this matrix is labeled RX from AG (receive from Access Grid).
This is where audio would leave the sound card and enter into the room
speakers. The Mackie Mixer used in this matrix has an audio output to the
room speakers.

• PC-audio-in in this matrix is labeled TX to AG (transmit to Access Grid).
This is where any audio from any of the audio sources at your node enter
into the sound card and get transmitted to the Access Grid.

• The echo cancellation output in this matrix is labeled Ghost Output.

• In this matrix, Sub Bus is an audio input channel used primarily to route
audio inputs into the room speakers.

3. Configure the matrix and the echo cancellation so that they match the image
below:
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4. Please note that this is the strongly recommended preset for ordinary day-to-day
operations on the Access Grid. In this preset:

• Inputs connected to room microphones are gated (have yellow boxes)
with the output connected to PC-audio-in.

• The input connected to pc-audio-out has a crosspoint (has a green box)
with the output connected to the room speakers.

• OPTIONAL CONNECTION-- To implement local reinforcement described
above, add these gatings and crosspoints:

• Choose the microphones who audio you would like to hear on the room
speakers. Inputs connected to the room microphones are gated (have
yellow boxes) to the column labeled Sub Bus 1.

• The row labeled Sub Bus 1 should have a crosspoint (have a green box)
with the output connected to the room speakers. On the matrix, this is
labeled PA System.

• PC-audio-out has a crosspoint (has a green box) with the unused output
used for echo cancellation.

• In the part of the matrix screen labeled "Echo Cancellation Setup", select
the output used for echo cancellation in the rows labeled "Define EC Ref
and PA" and "Define G-Link Ref".

5. Once you have completed configuring the matrix and setting up the echo
cancellation, return to the flow screen by pressing the button located in the
upper left-hand corner of the screen labeled something like "AP400 Flow
Screen".

Notes
1. http://www.gentner.com/tech_support/index.php

2. http://www.gentner.com/library/clearone_ap-ware_t100_tech_note.pdf
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Chapter 3. Labeling Connection Matrices

You can change some of the text in the input and output labels in the flow screen
(the screen with the diagrams) for each preset. This is not necessary for the Gen-
tner to function as required, but does make things a bit easier on the node oper-
ator during day-to-day operations. One text label you should consider including
is the output that serves as the echo cancellation. Standard practice to-date has
called for the naming of the echo cancelled output as the "Ghost Output". This
renaming process must be performed for every preset. Additionally, you should
remember to name things identically for all presets in order to minimize confu-
sion (unless there is node setup where this practice would not be reasonable).

The process for renaming the input and output labels consists of the following:

1. On the flow screen, click on any of the text appearing on the lines next to
input or output diagrams. This should cause a dialog box to appear that has
the title similar to "AP400 ([device number]) Input and Output Labels". The
image of the dialog box appears below:

2. Change the text of each input or output label to a more descriptive name.
Each text label may not exceed 16 (sixteen) characters.

3. Once you have completed renaming all of the inputs or outputs that you
wanted to rename, press the "OK" button.
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Chapter 4. Saving the Site Information

As the current state is saved in the Gentner itself, it is necessary to save informa-
tion related to this site that was entered in the AP-Ware software. This includes
the site properties and the text labels of the inputs and outputs for each setting.
There are two times when you can save the site information. The first time is to
select "Save As" from the "File" menu. Then, in the Windows file management
window that appears, enter the name of your choice as the file name. The exten-
sion .apd will be added to the end of the file name.

The other time is the following. You have disconnected the Gentner from the site
by selecting "Disconnect" from the "Connect" menu. First, you will a small win-
dow asking if you want to disconnect from the site. Press the "Yes" button. Then,
from the "File" menu, select "Exit". At this point, if there were any changes made
to the site information, the software will ask if you want to save your changes. If
you press the "Yes" button, the Windows file management window will appear,
and you can save the site information with the file name of your choice. After the
site information is saved, AP-Ware will exit.
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Chapter 5. Configuring Microphone Gain

Introduction to Configuring Microphone Gain
For each preset, you must configure the gain for your microphones. This is a fairly
straightforward operation; however, it is necessary to find the optimum gain that
seems to transmit the best audio to whoever is listening. If you want more de-
tailed information about all the various settings of the microphones, please con-
sult your Gentner manual. Provided here is enough information to enable you to
configure your microphone gain.

The process of configuring microphone gain is not by any means performed
in isolation. You should test your audio locally with the RTP packet reflector
located at http://www-unix.mcs.anl.gov/~olson/AG/Software/Linux/linux-
reflector.tar.gz or arrange time to test with a remote site. As you test your audio,
be aware of the gain of the microphone, the location of your room speakers in
relation to your microphones, and the loudness of the room speakers. This can
cause a problem known commonly as "echo". Remote sites will be able to tell
you if you are producing echo. If you are testing audio with remote sites, you will
never hear yourself echo.

Downloading and Using the RTP Packet Reflector
You will download the RTP packet reflector to the video machine because in part
you will still be using RAT to transmit and receive the audio. To download and
decompress the files, follow these steps:

1. To install the RTP packet reflector, save the file associated with this link:
http://www-unix.mcs.anl.gov/~olson/AG/Software/Linux/linux-
reflector.tar.gz.

2. Open a command window on the video machine. Type the following: tar -xzf
linux-reflector.tar.gz. This should create a directory containing the single
executable named reflector. Move the reflector directory to an appropriate
location.

To run the program, do the following:

1. On the video machine, open a command window and type the following:
[directory of reflector]/reflector 10000 . Substitute the full path name of the
reflector program in the appropriate area. A Tcl window should appear.

2. Set the minimum and maximum delay to be the same value. This is important
because it may sound like you have audio problems when you do not have
audio problems if these values are not set to the same value. For a three
second delay, use 3000.

3. Switch to the audio machine. On arm-eventlistener GUI, press the "Stop audio
tool" button.

4. Open a command window and type the following: rat -allow_loopback
[video machine name]/10000. Substitute the name of the video machine
in the appropriate area. RAT should appear and the only name that you
should see in the list of participants is the name of your node (as specified
in the RAT settings).

Now you are ready to test audio locally. It would be advisable to create icons
somewhere so that you do not have to type out these commands to test audio
locally.

Remember, when you are testing audio, pay attention to what the meters indicate
in RAT since this will visually indicate if your site is causing echo. When there
is sound coming out of the room speakers and the meter on the Listen meter is
moving of RAT, then you are causing echo. However, this may also occur if you
have a noisy room. As a guide, if the Listen meter is moving around a third of
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the way, it is probably likely that your site is causing echo. Please use your own
discretion as needed in evaluating echo.

Once you have finished testing audio locally, press the "Start audio tool" on the
arm-eventlistener GUI. Then, stop the reflector program on the video machine.
If you forget to stop the reflector program on the video machine, this should not
cause any adverse effects to your ability to use the Access Grid.

Configuring the Microphones Using AP-Ware
Remember that each preset has its own microphone settings. It is also likely that
the microphone settings in one preset may not be completely appropriate for an-
other preset. Testing is very important in this area in order to determine optimal
audio settings.

As you configure the microphones, try to run the RTP Packet Reflector so you are
able to get "real-time" audio feedback. Running the RTP Packet Reflector would
still be preferable to doing an audio test with a remote site that involved config-
uring the microphone settings. Finally, you will still be able to detect echo even
though by using the RTP Packet Reflector you are in a "loopback"/echo mode
already. What you are listening for is what could be called "double echo" (even
though this is not a formal definition by any means). A "double echo" occurs
when you hear yourself speak and then hear yourself a second time either with
the same level of audio loudness or a lower level of audio loudness. To solve this
problem, you can try to lower the volume of the room speakers or lower the Talk
gain on RAT. Sometimes, this will not solve the problem. In that case, it will be
necessary to adjust the gain of an individual microphone through the Gentner
AP-Tools software.

Some brief information will be presented that will help you to understand how
to configure the microphone settings using the AP-Tools software. It is recom-
mended that you consult the Gentner manual in order to have more detailed
information for audio term and setting explanations beyond what is described
here.

Described here is the graphical interface for inputs 1, 2, 3, and 4. The other graph-
ical interfaces for other inputs and outputs are somewhat similar in structure, but
consulting the Gentner manual or the AP-Ware online help for more information
on these other graphical interfaces. To display the graphical interface for inputs
1, 2, 3, and 4, make sure that you have the Flow Control visible for the AP-Ware
as seen below:

Press the button labelled "Inputs 1 - 4" to display the graphical interface for these
microphone inputs. Then the following should be seen:
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There are a few different sections of importance here with duplication of controls
and interface elements for each microphone. The first portion near the top of this
window control whether or not the microphone is muted, if the microphone uses
automatic gain control, and if phantom power is used. The second part labelled
"Gain Coarse/Fine" from the top controls the gain of the microphone. The third
part of the interface labelled "Meters" will display the pre-gain and post-gain
output of the microphone. The final part of interest configures the microphone to
implement echo cancellation and sets the level of nonlinear processing. The other
sections labelled "Gating" and "Processing" are not of importance here.

There is no specific order for configuring the microphones, but sometimes cir-
cumstances may dictate what settings are set first. Each subsection that follows
here will describe how to configure those settings for that part of the microphone:

• Mute, AGC, P Pwr

• Mute: If you are having a lot of trouble trying to configure a microphone,
or people are complaining about the audio from this microphone, block its
audio from going to the outside world by pressing the Mute button. This is
a toggle button, so press this button one time to mute and another time to
unmute. If the microphone is muted, the interface should show a bright red
line in this microphone section.

• AGC: This is an acronym for Automatic Gain Control. This is a toggle button
like the Mute button. When the AGC has been selected, a bright green line
should appear. It is not recommended to activate the AGC setting unless your par-
ticular microphone recommends this setting or your node necessitates this setting.

• P Pwr: This phrase stands for Phantom Power. This setting is a toggle button
just like the Mute and AGC buttons. When it is activated, a bright green line
should appear. Select this setting if your microphone does not use a battery

• Gain Coarse/Fine

• Please note that dB stands for decibels, a unit of audio measurement. More
decibels as a positive value indicates that the sound is louder, while more
decibels as a negative value indicates that the sound is quieter.

• Left Slider (Coarse Gain): This setting allows you to change the microphone
settings using large intervals. The number represented to the right of the
slider will be the "base level" loudness of the microphone (I am not an audio
engineer, so "base level" is my terminology.) If the person using this micro-
phone tends to be consistently soft, it would probably be a good idea to have
this set at 25 dB or 55 dB. The setting of 55 dB should only be considered if
it is very difficult to hear a person using this microphone. 25 dB is probably
the preferred setting. Remember, setting microphone gain too high can result in
an echo heard by other sites. Also, if the microphone that has a high coarse gain is
very near to the room speakers, this may also result in echo.

• Right Slider/"Spinner" (Fine GGain): This setting allows you to change the mi-
crophone settings using very small intervals (that is, 1 decibel [dB]). The
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number represented to the right of the slider will be the value in decibels
added to the coarse gain value. The value set by the slider will also appear
in the small text line below the sliders. You also have the ability to change
the value of the fine gain using the "spinner" or the little up and down arrow
buttons that appear to the right of the small text line which contains the fine
gain value in decibels. Ideally, you should have the fine gain set between
-5 dB and +5 dB. This is just a suggestion since different room acoustics,
types of microphones, and placement of microphones may necessitate dif-
ferent settings. Avoid setting the fine gain between +18 dB and +20 dB since this
high setting may introduce echo heard by other sites. Also, if the microphone that
has a high fine gain is very near to the room speakers, this may also result in echo.

• Meters

• In order to display the meter for a microphone, it is necessary to select the
check box in the center of this part. It is a toggle area. When the checkbox is
checked, the meter will display values. When the checkbox is not checked,
the meter will not display any values. Only one microphone may display its
meter at a single time. To get around this problem, select from the menu named
"View", the menu item "Meter View". Then configure this display as needed,
and make sure to select a "Meter Type" of "Input Post Gain". "Input Post
Gain" will show the meter value that would indicate how well remote sites
are able to hear the audio from that particular microphone.

• Pre-Gain: This is the raw decibel amount coming directly into the microphone
before any gain settings are applied to the audio signal. Most people are gen-
erally interested in the audio signal after gain has been applied, so this meter
may not be that relevant to you unless you may be checking for problems
with some physical aspects of the microphone, as an example. The text area
below this meter indicates the exact value given in decibels of the "loudness
of the audio" (my terminology).

• Post-Gain: This is the decibel amount sent to the remote sites after the gain
settings have been applied to the audio signal. Most people will typcially be
interested in the values given by this meter. The text area below this meter
indicates the exact value given in decibels of the "loudness of the audio" (my
terminology).

• EC and NLP

• EC: This stands for echo cancellation. If the checkbox is checked, echo can-
cellation will be applied to this microphone. If the checkbox is not checked,
then echo cancellation will not be enabled for this microphone. Unless there is
a good reason, always make sure that echo cancellation is enabled for all microphones
for all presets.

• NLP: This stands for Non-Linear Processing. This setting will assist the mi-
crophone in providing additional echo cancellation capabilities. According
to the AP 400 Audio Conferencing System Installation and Operation Manual,
there are three settings named "soft", "medium", "aggressive", and "off". Each
of these sesettings (not including "off") provides 6 dB, 12 dB, and 18 dB of
"additional echo cancellation power". If the microphone is in a noisy envi-
ronment or, as the manual indicates, a "difficult acoustic [environment]", you
will want to set the NLP to "medium" or "aggressive". Please take care not to
set the NLP too high since there are different trade-offs.
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That is about all for configuring microphones. Remember, the best way to get
immediate audio feedback is to use the RTP Packet Reflector.

Notes
1. http://www-unix.mcs.anl.gov/~olson/AG/Software/Linux/linux-

reflector.tar.gz

2. http://www-unix.mcs.anl.gov/~olson/AG/Software/Linux/linux-
reflector.tar.gz
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